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Spreadsheets are powerful tools for, storing data, making complex calculations, and creating 
charts and graphs. Originally, spreadsheets and databases were very distinct, but newer 
spreadsheets have taken over many of the functions of databases. Spreadsheets are still a poor 
choice for storing very complex data, particularly when several different kinds of data interact 
with one another (such as in a scheduling program that relates students to teachers to classrooms 
to courses to course sections); for that kind of task, choose a relational database product like 
Microsoft Access or Filemaker Pro. However, for most personal needs, a spreadsheet is a good 
choice. 
 
A spreadsheet consists of a table of cells organized in columns and rows. Columns are 
designated by letters and rows are designated by numbers, so a particular cell can be identified 
by its column letter and row number. For example, cell C17 would be in column C row 17. 
 
The figure below shows some of the main elements of a spreadsheet. The picture is from Excel 
2002. Excel 2003 looks identical to this. While the overall look and menu structure has changed 
in Excel 2007, the parts labeled below remain the same. 
 

Formula Bar 
Column Letters 

Row 
Numbers 

 
 
Data is put into cells, but as you type your data, you type in the formula bar. Some versions of 
some spreadsheets also show the data in the cells as you type, but you generally want to look in 
the formula bar and edit the data in the formula bar. 
 
Cells in a spreadsheet are independent of one another. That is, just because a cell is next to 
another cell or below it does not mean that it has the same kind of information or information 
about the same kind of thing. However, you are likely to set up your spreadsheet in way that 
makes sense so cells near each other are related to one another. Most spreadsheets that you create 
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will be tables with rows and columns. I hear you cry, “The spreadsheet is made up of rows and 
columns so doesn’t my table have to be in rows and columns?” The answer is “no.” The overall 
spreadsheet is organized that way, but that does not mean that your data has to be organized that 
way. You can put anything into any cell and anything else into the cell next to it with no 
organization at all. However, you generally won’t do that. You might, for example, have a 
spreadsheet of grades for your students. Row 1 will have headers for the table. The rest of the 
rows will each have one student in them. Row 2 might be for John Smith and have all his grades; 
row 3 might be for Juanita Jones and have all her grades, etc. 
 
Moving Around the Spreadsheet 
 
There are several ways to move around a spreadsheet. You can point your mouse to any cell and 
click. You will notice that the dark box (that is around cell A1 in the above figure) will move to 
whatever cell you have clicked. Whatever cell is selected will be where your data will go. 
 
You can also move from cell to cell by using the arrow keys on your keyboard. The right arrow 
key will move you to the right one cell, the left arrow key will move you to the left one cell, the 
up arrow key will move you up one cell, and the down arrow key will move you down one cell. 
 
You can also use Tab to move to the right, shift-Tab to move to the left, Enter to move down, 
and shift-Enter to move up. 
 
The following table summarizes the different ways to move around within a spreadsheet. 
 
Keyboard Key or Action Result Special Notes 
Clicking on a cell Moves to the cell that is 

clicked 
When entering a formula into a cell, 
clicking on another cell will insert the 
cell number into the formula and not 
move to that cell 

Tab key Move to the right one 
cell 

 

Shift-Tab Move to the left one cell  
Enter Move down one cell Enter will try to be smart and move you 

to the beginning of the next row. Also, in 
the Options, Enter can be set to enter the 
information from the formula bar 
without moving to a new cell, or it can 
be set to move in a direction other than 
down. 

Shift-Enter Move up one cell If Enter is set so that it does not move to 
a new cell, Shift-Enter will not move to a 
new cell. Whatever direction Enter is set 
to move, Shift-Enter will do the opposite 
(e.g., if Enter is set to move to the right, 
Shift-Enter will move to the left). 
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Green check mark  
(not green in 2007) 

Enter the information in 
the formula bar without 
moving 

The green check mark appears to the left 
of the formula bar as soon as you start 
typing something in the formula bar. 

Red X  
(only red in 2007 when 
you point to it) 

Cancel whatever is in 
the formula bar and 
leave the cell 
unchanged. 

The Red X appears to the left of the 
formula bar as soon as you start typing 
something in the formula bar. 

 
Simple Data Entry 
 
The simplest way to enter data is to type it. What you type will show up in the formula bar, and 
depending on the settings of your computer, in the cell itself. However, the data is not entered 
into the cell until you accept it. Almost all the methods of moving around will accept the data in 
the cell, but the most common are to hit the Tab key to accept the data and move to the cell to the 
right (so you are ready to type in the next cell), hit the Enter key to accept the data and move to 

the next row, or click on the check mark  to accept the data without moving. 
 
Formatting Data 
 
Once you have entered your data, you will want to format it. You can do many of the things that 
you do in a word processor within each cell. For example, any individual cell can be made bold 
or italic or underline; any individual cell can have a different font or font size; and any individual 
cell can be left, right, or center justified. Simply click on the cell and use the tools in the format 
toolbar in Excel 2003 and earlier: 

 
Or click on the cell and choose Cells from the Format menu. Most standard formatting (things 
you would do with a word processor) can be found in the Alignment or Font tabs. 
 
In 2007, you will use the Home Ribbon to do basic formatting: 

 

font size 

bold, 
italic, 

underline 

left, center, 
right justify 

bold, 
italic, 

underline 

font size left, center, 
right justify 
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In 2003 and earlier, choosing Cells from the Format menu and clicking on the Number tab, gives 
you several options for formatting different kinds of data. 
 

 
 

In 2007, you can get some basic cell formats in the Number section of the Home Ribbon. You’ll 
see a drop down menu, probably set to General, and you can get several popular format options. 
If you choose More Options from the pull-down menu, you will see a dialog box similar to the 
one above. 
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On the left is a list of types of data that your cell can contain. The General category lets Excel 
make its best guess as to how to display the data. This works for many things, but not everything. 
If you choose number or currency, you will have the option to specify how many decimal places 
should be displayed, whether to separate thousands, millions, etc. places with commas, and how 
to handle negative numbers. 
 

Sample of how 
your number will 
look. 

Check the box if you want 
commas to separate 
thousands, millions, etc. 
places. 

Specify how negative 
numbers are handled: 
using minus, using a red 
font, using parentheses, 
etc. 

 
 
The currency category also gives you the option to choose what currency symbol you want, such 
as dollars ($) or pounds (₤). 
 
If you are entering dates, you can use the Date category to choose the format of the date to 
include the month in numbers or words, the day of the week, etc. 
 
Note that changing the format of the number or date does not change the number itself, just how 
the number or date is displayed. If you accidentally choose to display a number as a date, for 
example, it will look like a date, but when you change the format back to number, it will look 
like a number once again. 
 
Formatting Several Cells at Once 
 
Any formatting changes you can make to one cell can be made to several cells at the same time. 
First, select the range of cells that you want and then change the formatting as described above. 
You can select an entire row by clicking on a row letter. You can select an entire column by 
clicking on a column number. And you can select any group of cells by pointing the mouse to the 
first cell in the group and holding the left mouse button down and dragging across the range. 
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In this picture, you can see that cells B2 through F10 are selected, so any change in formatting 
will affect all of those cells. You should notice that the entire block of cells has a thick box 
around it, and all but the first cell are shaded. Even though the first cell (B2 in this case) is not 
shaded, it is still selected and formatting changes will affect it. 
 
You can also select cells that aren’t next to each other by highlighting a block of cells, holding 
down the Control key (Command or “Apple” key on a Mac) and highlighting another block of 
cells. 
 
Column Widths 
 
You might notice that as you type data, it might not always fit in your cells. At other times, you 
might notice that data might fit in your cells with lots of extra room. In the first case, you can’t 
see everything in your spreadsheet. In the second case, you are wasting space. While you won’t 
adjust the width of an individual cell, you can adjust the width of an entire column. To do this, 
move your mouse between the column letters of two columns until your cursor changes to a line 
with two arrows pointing out: 

 
 

When your cursor looks like this, you can either drag the line between the columns to adjust the 
column size, or you can double-click your mouse. Double-clicking will make the column just the 
right size to hold the data that is currently in that column. 
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No Numbers – Just ######## 
 
Sometimes your cells are not wide enough to hold your data. For some things, such as text, Excel 
will display as much as it can. For other things, such as numbers and dates, it will not. Instead, it 
will fill the cell with number signs: #########. This indicates that there is something in the cell, 
but it is not big enough to show the whole thing. This will avoid confusion if, for example, you 
have typed 100 in a cell, but it is only wide enough to display two digits. You wouldn’t want to 
think that the number in the cell is 10 (if the last digit is cut off). Instead, you will see ##, and 
you will have to widen the cell’s column to see the entire number. 
 
Calculations 
 
Formatting data is very nice and convenient, but you could do most of the formatting in a word 
processor if that was all you wanted to do. The real power of spreadsheets lies in its ability to 
calculate. 
 
In the simplest formulas, you use +, -, *, and / to add, subtract, multiply, and divide, respectively. 
All formulas must start with an equal sign (=) to let Excel know that it is supposed calculate 
something, not just put the text you type into the cell. If you want to add six and seven, you 
could type the following: 
 

=6+7 
 

If you want to multiply six and seven, you could type the following: 
 

=6*7 
 
Of course, that is not very powerful. The real power comes when we base our formulas on data 
that is already typed in the spreadsheet. If you want, to add the contents of cells G2 and H2, you 
could type the following: 
 

=G2+H2 
 

In the following example, a table lists the number of books read by each of three classes, 
specifically how many in each class read The Cat in the Hat, Horton Hears a Who, and The 
Lorax. Cell E3 contains a formula to add the total number of books read by Class A. 
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To enter the cell numbers in the formula, you can either type the cell numbers yourself, or you 
can click on each cell when it’s time to enter that cell in the formula. For example, you might do 
the following to enter the formula: 
 

• Click on cell E3 to select it 
• Type = 
• Click on cell B3 (containing the number 12) 
• Type + 
• Click on cell C3 (containing the number 7) 
• Type + 
• Click on cell D3 (containing the number 3) 

• Click on the check mark  to accept the formula. 
 
The spreadsheet will add up the numbers to get the answer, and it will display the answer (22) in 
the cell. What’s more, the spreadsheet will update that answer if the numbers get updated. That 
is, if three more students read The Lorax, and you change the 3 in cell D3 to 6, cell E3, will 
automatically change to 25. 
 
The formulas can be more complicated, representing any mathematical expression you can 
imagine (Excel can do just about anything short of calculus). For example, suppose the books 
were worth points, and the class with the most points was going to be rewarded with a pizza 
party. However, The Cat in the Hat is a fairly easy book so it is only worth one point. Horton 
Hears a Who is harder so it is worth two points, and The Lorax is the hardest of all so it is worth 
four points. You could type the following formula to determine the total points for each class: 
 

=(1*B3)+(2*C3)+(3*D3) 
 

As you try to figure out more complex formulas, be sure to separate any math anxiety you might 
have from any computer anxiety you might have. That is, figure out how you would calculate 
what you want to calculate mathematically (if you were going to use pencil and paper or a 
calculator), then figure out how translate that into something that the computer would 
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understand. If you suffer from both math and computer anxiety, and you try to create a complex 
formula for the computer all at once, you could have a nervous breakdown. By worrying about 
the math first and the computer second, you have a chance to maintain your mental health. 
 
Filling Formulas 
 
Once you have created a formula for one row of your table, you could do exactly the same thing 
to create formulas for all your other rows. However, that would be a waste of time. For our three-
row example, that wouldn’t be a big deal, but imagine a more complicated formula and/or more 
rows. That could take a very long time. Instead, we will use our friend Fill to do most of the 
work for us. 
 
Once you have set up the formula in one row, you should highlight all the cells where you want 
the formula including the cell in which you just put the correct formula. The cell with the 
formula will be used as the example. In 2003 and earlier, from the Edit menu, choose Fill, and 
from the menu that flies out, choose Down. 
 

 
 

In this figure, notice the highlighted cells and the selection from the Edit menu. 
 
In 2007, Fill can be found on the Home Ribbon in the Editing section (far right of the ribbon): 
 



Spreadsheets  Page 10 

 
 
You will also notice that you can Fill Right, Up, and Left if you create a formula that you need to 
duplicate to cells that are not below the cell with the formula. 
 
If you click in cell E3, you will see, in the formula bar, the original formula we typed: 
=B3+C3+D3. If you go down to row 4 and click in cell E4, you will see that the formula is 
changed slightly: =B4+C4+D4. Excel was smart. It knew that you were adding numbers in row 3 
for cell E3, so you would probably want to add numbers in row 4 for cell E4 and row 5 for cell 
E5. If you don’t want Excel to update the row numbers for you, precede each row number with a 
dollar sign in your formula: 
 

=B$3+C$3+D$3 
 

Then when you Fill Down, the 3s will not change to 4s. This would be useful if we used the 
point system, but we included the point values for our book in row 3. 
 

 
 
In this example, the only thing we don’t want to change are the cell numbers for the point values 
so they have dollar signs (B$3, C$3, and D$3), but we do want to change the row numbers for 
the number of books read so those numbers do not have dollars signs (B4, C4, and D4). 
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Functions 
 
Many things that you want to do can be done with simple formulas using +, -, *, and /. 
Sometimes, however, the formulas get very long and cumbersome, and other times what you 
want to do is more advanced and can’t be done with simple operators. Excel has a large number 
of built-in functions. These functions can do a wide range of arithmetic, statistical, and logical 
operations. Excel can do just about anything short of calculus. 
 
Remember, you don’t always need functions +, -, *, and / will work, but functions can save you 
time. The simplest function is the SUM function. SUM can be used to add together a bunch of 
numbers. In our earlier example, we used + to add together the number of books read 
(=B3+C3+D3). This could also be done with the SUM function: 
 

=SUM(B3,C3,D3) 
 

When SUM is used in this way, it looks at each number inside its parentheses and adds them 
together (note that the numbers are separated by commas). Alternatively, you could use: 
 

=SUM(B3:D3) 
 
This adds together a range of cells from B3 through D3. They both work the same, but B3:D3 is 
easier to type than B3,C3,D3, and much easier if you are adding up more than three numbers. 
 
As you type formulas, you don’t have to type cell numbers. You can click on cells instead of 
typing their cell numbers. For a range of cells, instead of typing or clicking, you can drag your 
mouse across the range of cells, and the range will be automatically entered into your formula. 
 
The most common functions you can use are SUM, AVERAGE, MIN, and MAX (to add up 
numbers, find the average of numbers, find the smallest of a group of numbers, and to find the 
largest of a group of numbers). Each of these functions works in the same way with cell numbers 
separated by commas or a cell range. 
 
While you can type in the name of the function as described above, you might want to insert it 
from a menu. Let’s use our earlier example and add a row at the bottom to calculate the average 
number of each book read by all the classes. To do this in 2003 or earlier, I would click on an 
empty cell at the bottom of Column B and choose Function from the Insert menu. A dialog box 
will pop up that looks like the following: 
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The drop-down menu allows you to select a category of functions. Often what you want will be 
listed under the “Most Recently Used” category. If it’s not, you will have to choose a category. 
Because I can never remember what category anything should be under, I usually choose “All” 
to show all the functions. I can never remember, for example, if AVERAGE should be found 
under the “Math & Trig” category or the “Statistical” category. By choosing “All,” you see a 
long list of functions in the bottom portion of the dialog box. Use the scroll bars to scroll through 
until you see the function you want. 
 
In 2007, you can get to the same menu by choosing the Formulas Ribbon and clicking on the 
Insert Function button on the far left of the ribbon. Alternatively, you can choose a category from 
one of the categories and pick a function from the drop-down menu. 
 

 
 
If you are not sure which function you want, you can either search for a function by describing it, 
or you can click on a function and look at the bottom of the dialog box for a description of that 
function. 
 
In our case, we want the AVERAGE function. If you click on the AVERAGE function and click 
OK, you will be presented with another dialog box: 
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I call this dialog box, “The Dialog of Guessing.” In this dialog box, Excel has tried to guess what 
you want to average. It has guessed B3:B5; i.e, the range of cells from B3 through B5. In this 
case, it is correct. Unfortunately, I find that it is wrong over half the time so I usually ignore what 
it has guessed. 
 
If Excel is wrong (or you want to ignore its guess because it is often wrong), you can simply 
click OK and ignore what it has typed in the formula bar. What it has done isn’t entirely useless 
because the dialog box gave you a description of the function and information about how it is 
used. 
 
Once we click OK, we get the following in the formula bar: 
 

=AVERAGE(B3:B5) 
 

To ignore this, delete what is between the parentheses so you have: 
 

=AVERAGE() 
 

Be sure your cursor is flashing between the parentheses. Now, you can either type cell numbers 
separated by commas: 
 

=AVERAGE(B3,B4,B5) 
 

or click on cell numbers separated by commas 
 

• Click on B3 
• Type a comma 
• Click on B4 
• Type a comma 
• Click on B5 
• Type a comma 
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or drag your mouse across a range of cells to get: 
 

=AVERAGE(B3:B5) 
 

Notice that this is the same as what Excel guessed, but that won’t always happen. As you drag 
the mouse across a range of cells, notice that the numbers inside the parentheses change 
automatically. 
 
Sample Calculations 
 
The following page shows a spreadsheet with some example calculations. The table that follows 
shows the formulas in each of the cells that use formulas. This spreadsheet should give you ideas 
of some of the things that you can use formulas to calculate. It includes formulas that were 
described earlier and formulas that were not. It uses + for addition as well as SUM and 
AVERAGE functions. It uses the COUNT function to count the number of Xs in a range of cells. 
It uses the IF function to determine the correct gendered pronouns in rows 14 through 18, 
checking in column B for the gender and putting the correct male or female pronoun in columns 
C through E. Finally, it shows a sample gradebook in which homeworks are worth 10% of the 
grade, quizzes are worth 40% of the grade and tests are worth 50% of the grade. The formula to 
calculate the average is somewhat complex but realistic for a gradebook. The last column uses a 
fairly complex series of IF statements to convert the numerical average to a letter grade. 
 
With these examples, you might be able to figure out how to use some of these functions, but 
these are merely examples to show you the range of possibilities of what Excel can do. 
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Cell Formula 
A7 =AVERAGE(A3:A6) 
E7 =SUM(E3:E6) 
H5 =H3+H4 
H10 =COUNTIF(B10:G10,"X") 
C14 =IF(B14="m","he","she") 
C15 =IF(B15="m","he","she") 
C16 =IF(B16="m","he","she") 
C17 =IF(B17="m","he","she") 
C18 =IF(B18="m","he","she") 
D14 =IF(B14="m","him","her") 
D15 =IF(B15="m","him","her") 
D16 =IF(B16="m","him","her") 
D17 =IF(B17="m","him","her") 
D18 =IF(B18="m","him","her") 
E14 =IF(B14="m","Mr.","Ms.") 
E15 =IF(B15="m","Mr.","Ms.") 
E16 =IF(B16="m","Mr.","Ms.") 
E17 =IF(B17="m","Mr.","Ms.") 
E18 =IF(B18="m","Mr.","Ms.") 
J22 =(0.1*AVERAGE(B22,C22,E22,G22)+0.4*AVERAGE(D22,F22)+0.5*AVERAGE(H22,I22)) 
J23 =(0.1*AVERAGE(B23,C23,E23,G23)+0.4*AVERAGE(D23,F23)+0.5*AVERAGE(H23,I23)) 
J24 =(0.1*AVERAGE(B24,C24,E24,G24)+0.4*AVERAGE(D24,F24)+0.5*AVERAGE(H24,I24)) 
J25 =(0.1*AVERAGE(B25,C25,E25,G25)+0.4*AVERAGE(D25,F25)+0.5*AVERAGE(H25,I25)) 
J26 =(0.1*AVERAGE(B26,C26,E26,G26)+0.4*AVERAGE(D26,F26)+0.5*AVERAGE(H26,I26)) 
K22 =IF(J22>=90,"A",IF(J22>80,"B",IF(J22>70,"C",IF(J22>60,"D","F")))) 
K23 =IF(J23>=90,"A",IF(J23>80,"B",IF(J23>70,"C",IF(J23>60,"D","F")))) 
K24 =IF(J24>=90,"A",IF(J24>80,"B",IF(J24>70,"C",IF(J24>60,"D","F")))) 
K25 =IF(J25>=90,"A",IF(J25>80,"B",IF(J25>70,"C",IF(J25>60,"D","F")))) 
K26 =IF(J26>=90,"A",IF(J26>80,"B",IF(J26>70,"C",IF(J26>60,"D","F")))) 
 


